
Q.1 Who was honoured with the title 'Assam Kesari' for his courageous role in the Indian
freedom movement?

Ans 1. Tarun Ram Phukan

2. Ambikagiri Raichoudhury

3. Gopinath Bordoloi

4. Chandraprabha Saikiani

Q.2 In a certain code language, ‘MUST’ is coded as ‘4268’ and ‘SALE’ is coded as ‘3527’.
What is the code for ‘S’ in the given code language?

Ans 1. 2

2. 3

3. 7

4. 6

Q.3 Who inaugurated 'Srjanam', a biomedical waste conversion system, at AIIMS Delhi in
2025?

Ans 1. NITI Aayog Member

2. Union Minister for Science and Technology

3. Director of AIIMS Delhi

4. Director of CSIR-NIIST

Q.4 What major tax reform was introduced by the 101st Amendment Act, 2016?
Ans 1. Income Tax

2. Excise Duty
           

3. Goods and Services Tax (GST)

4. Wealth Tax

Q.5 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which letter-cluster pair DOES NOT
belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. LR – QM

2. HN – MI

3. BH – GC

4. WC – BY
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Q.6 Anti-dumping and anti-subsidies & countervailing measures in India are administered
by which Ministry?

Ans 1. Ministry of External Affairs

2. Ministry of Finance

3. Ministry of Commerce and Industry

4. Ministry of Home Affairs

Q.7 In which year did the English East India Company pass a new law that required every
new person who took up employment in the Company’s army to serve overseas if
required?

Ans 1. 1856

2. 1850

3. 1840

4. 1860

Q.8 Which of the following numbers is divisible by 87?
Ans 1. 7221

2. 7741

3. 7099

4. 6712

Q.9 The ratio between the perimeter and breadth of a rectangle is 3 : 1. If the area of the
rectangle is 98 cm2, find the perimeter (in cm) of the rectangle.

Ans 1. 47

2. 42

3. 38

4. 50

Q.10 If α, β and γ are the roots of the equation 6x3 − 11x2 + 6x − 1 = 0, find Σα2βγ.
Ans

1. 

2. 

3. 

4. 

Q.11 M is inversely proportional to N. If M is 18, then N is 21. If N = 27, then what is the value
of M?

Ans 1. 12

2. 13

3. 16

4. 14

Q.12 According to the Press Information Bureau, by what percentage did India's Defence
Public Sector Undertakings (DPSUs) exports grow in the fiscal year 2024-25 compared
to the previous year?

Ans 1. 25.5%

2. 50.2%

3. 35.7%

4. 42.85%
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Q.13 Which bank has officially partnered with Sunrisers Hyderabad (SRH) as its exclusive
banking partner in March 2025?

Ans 1. HDFC Bank

2. Axis Bank

3. ICICI Bank

4. City Union Bank

Q.14 Which Fundamental Right was introduced by the 86th Constitutional Amendment Act of
2002 specifically for children?

Ans 1. Right to free electricity

2. Right to vote

3. Right of children to free and compulsory education

4. Right to travel abroad

Q.15

Ans 1. 3

2. 13

3. 17

4. 18

Q.16 The curved surface area of a cylinder is half of its total surface area. If its height is 195
cm, then find its diameter (in cm).

Ans 1. 381

2. 383

3. 393

4. 390

Q.17 The speed of a boat in still water is 9 km/hr and the speed of the stream is 5 km/hr. A
man rows to a place at a distance of 75.6 km and comes back to the starting point. Find
the total time (in hours) taken by him.

Ans 1. 19.3

2. 24.3

3. 20.8

4. 26.6

Q.18 What should come in place of the question mark (?) in the given series?

13 8 24 19 57 52 156 ?
Ans 1. 169

2. 155

3. 140

4. 151

Q.19 Bholanath Singh was the leader of which of the following revolts?
Ans 1. Tamar Revolt

2. Farazi Movement

3. Santhal Revolt

4. Wahabi Movement
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Q.20 At what rate of interest per annum will a sum of ₹15,625 amount to ₹19,683 in 1 year and
6 months, if the interest is compounded half-yearly?

Ans 1. 20%

2. 16%

3. 19%

4. 8%

Q.21 In MS Word 2019, which of the following features can you use to change the page
orientation of your document?

Ans 1. Insert → Page Number

2. Review → Spelling & Grammar

3. View → Print Layout

4. Page Layout → Orientation

Q.22 If 1 is added to each odd digit and 1 is subtracted from each even digit in the number
8631247, what will be the sum of the digits that are third from the left and first from the
right?

Ans 1. 11

2. 12

3. 8

4. 9

Q.23 7 times the present age of X is 6 years less than 2 times the present age of Y. At present,
P is 7 times as old as X, and Y is 6 years younger than Q. If P is 70 years older than Q,
then the present age (in years) of Y is:

Ans 1. 75

2. 73

3. 82

4. 78

Q.24 In Windows-based systems, which Alt key combination is most likely to display the
contextual control menu of the active window, especially when the title bar is
inaccessible?

Ans 1. Alt + F4

2. Alt + Del

3. Alt + F10

4. Alt + Space

Q.25 Nilgiri Biosphere Reserve spans which of the following groups of Indian states?
Ans 1. Kerala, Telangana, Tamil Nadu

2. Andhra Pradesh, Tamil Nadu, Kerala

3. Tamil Nadu, Kerala, Karnataka

4. Maharashtra, Goa, Karnataka

Q.26 Manish ranked 18th from the top and 49th from the bottom in his class. How many
students are there in his class?

Ans 1. 66

2. 64

3. 67

4. 65
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Q.27 Which of the following statements about the December 2024 appointments to the
National Human Rights Commission (NHRC) is INCORRECT?

Ans 1. The appointments were made by the President of India in December 2024.

2. Justice V Ramasubramanian was appointed as the Chairperson of NHRC.

3. Shri Priyank Kanoongo was appointed as the Secretary General of NHRC.

4. Justice (Dr.) Bidyut Ranjan Sarangi joined NHRC as a Member.

Q.28         F is the husband of G. G is the mother of H. H is the husband of I. I is the mother of J.
How is F related to J?

Ans 1. Mother's father

2. Father's brother

3. Father's father

4.  Mother's brother

Q.29 Let ABC and DEF be two triangles such that ∠A = ∠D = 40° and AB = DE. What is the
condition required to be met such that ABC and DEF are similar triangles?

Ans 1. ∠C = ∠F

2. BC = EF

3. ∠B = ∠F

4. ∠B = ∠D

Q.30 If the median of a data is 45.98 less than its mode, then the median of the data exceeds
its mean by _____. (Use empirical formula)

Ans 1. 25.13

2. 21.05

3. 26.54

4. 22.99

Q.31 Anuj starts from Point A and drives 12 km towards East. He then takes a right turn,
drives 8 km, turns right and drives 14 km. He then takes a right turn and drives 11 km.
He takes a final right turn, drives 2 km and stops at Point P. How far (shortest distance)
and towards which direction should he drive in order to reach Point A again? (All turns
are 90° turns only, unless specified.)

Ans 1. 2 km to the south

2. 3 km to the south

3. 4 km to the south

4. 1 km to the south

Q.32 On simple interest, a certain sum of money amounts to ₹1,750 in 2 years and to ₹3,250
in 4 years. Find the rate of interest per annum.

Ans 1. 299%

2. 301%

3. 300%

4. 302%
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Q.33 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
All cows are emu.
All emus are ostrich.
Some ostriches are duck.

Conclusions:
(I) Some ducks are cows.
(II) All ostriches are cows.

Ans 1. Both conclusions (I) and (II) follow

2. Only conclusion (I) follows

3. Neither conclusion (I) nor conclusion (II) follows

4. Only conclusion (II) follows

Q.34 A factory produces 15, 20, 25, 10, and 30 units of a gadget over five days. What is the
average production (in units) per day?

Ans 1. 20

2. 18

3. 22

4. 24

Q.35 I, J, K, L, M and Y live on six different floors of the same building. The lowermost floor in
the building is numbered 1, the floor above it, number 2 and so on, till the topmost floor
is numbered 6. Only L lives above Y. I lives on some floor below J. Only M lives below K.
How many people live between J and M?

Ans 1. Three

2. Two

3. One

4. Four

Q.36 What should come in place of the question mark (?) in the given series based on the
English alphabetical order?

XDO BBQ FZS JXU ?
Ans 1. OWV

2. LWX

3. MUX

4. NVW

Q.37 P, Q, R, S, T, U and V have an exam on different days of the week starting on Monday
and ending on Sunday. Q has an exam on Friday. Exactly 3 people have an exam
between R and T, neither of whom has on exam on Sunday. P has an exam immediately
after U. V has an exam immediately before T. Who among the following has an exam on
Wednesday?

Ans 1. V

2. R

3. U

4. S

Q.38 The mention of DNA as a long polymer of deoxyribonucleotides implies which structural
characteristic?

Ans 1. It is composed of a sugar-phosphate backbone and nitrogenous bases.

2. Each nucleotide is linked by hydrogen bonds in a parallel fashion.

3. The molecule consists of multiple independent short chains.

4. The sequence is circular and self-replicating.
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Q.39 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.
(NOTE: All numbers are single digit numbers only.)

(Left) 7 @ £ 1 @ 7 # * 8 7 8 6 5 3 8 4 € # £ 9 1 £ (Right)

How many such symbols are there each of which is immediately preceded by a number
and also immediately followed by a number?

Ans 1. 0

2. 1

3. 3

4. 2

Q.40

Ans
1. 

2. 

3. 

4. 

Q.41 The award (decision) made by the Lok Adalats is deemed to be a decree of a civil court
and is final and binding on all parties because:

Ans 1. An appeal can be filed in the High Court

2. An appeal can be filed in the Supreme Court

3. No appeal is permissible

4. A review petition can be filed

Q.42 Income of Amit in 2019 was ₹22,000. He gets an increment of 20% every year. What was
his income (in ₹) in 2021?

Ans 1. 31,680

2. 30,800

3. 22,000

4. 26,400

Q.43 When appointing Governors of States and Lieutenant Governors of Union Territories,
the President of India acts on the advice of which body?

Ans 1. The State Legislatures

2. The Supreme Court of India

3. The Election Commission

4. The Union Council of ministers

Q.44 ‘Pradeshtris’ word is used for which officers during the Mauryan Empire?
Ans 1. Chief minister

2. Officers responsible for suppression of criminals

3. Commander of army

4. Judges
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Q.45 In which type of musical instruments, sound is produced by blowing air into a hollow
column?

Ans 1. Ghana Vadya

2. Avanaddha Vadya

3. Tata Vadya

4. Sushira Vadya

Q.46 Which shortcut key combination is used to insert a hyperlink in MS PowerPoint 365?
Ans 1. Ctrl + Shift + X

2. Ctrl + K

3. Ctrl + N

4. Alt + X

Q.47 In a certain code language, ‘MEAN’ is coded as ‘6248’ and ‘AIDS’ is coded as ‘5721’.
What is the code for ‘A’ in the given code language?

Ans 1. 4

2. 2

3. 7

4. 5

Q.48 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.
(NOTE: All numbers are single digit numbers only.)

(Left) 3 # 6 5 2 @ 8 * 7 9 1 % 2 8 1 9 3 # 1 £ © 7 (Right)

How many such numbers are there each of which is immediately preceded by a number
and also immediately followed by a symbol?

Ans 1. 4

2. 2

3. 3

4. 5

Q.49 The average of eight numbers is 14. The average of five of these numbers is 14. The
average of the remaining three numbers is:

Ans 1. 14

2. 13

3. 16

4. 15

Q.50 Vinod starts from point A and drives 8 km towards the west. He then takes a left turn,
drives 6 km, turns left and drives 12 km. He then takes a left turn and drives 11 km. He
takes a final left turn, drives 4 km and stops at point P. How far (shortest distance) and
towards which direction should he drive in order to reach point A again? (All turns are
90-degree turns only unless specified.)

Ans 1. 6 km to the south

2. 6 km to the north

3. 5 km to the south

4. 5 km to the north
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Q.51 Each of the digits in the number 691478325 is arranged in ascending order from left to
right. What will be the sum of the digits that are third from the left and second from the
right in the new number thus formed?

Ans 1. 10

2. 11

3. 12

4. 9

Q.52 In which of the following countries did the United Nations Biodiversity Convention 2024
(COP16) conclude in February 2025?

Ans 1. Germany

2. Italy

3. France

4. Colombia

Q.53 Seven friends, A, B, C, D, P, Q and R, are sitting in a straight line facing north. Only two
people sit to the left of R. Only three people sit between R and P. Only one person sits
between P and A. D sits to the immediate left of Q. B is not an immediate neighbour of P.
How many people sit to the right of C?

Ans 1. Two

2. Three

3. One

4. Four

Q.54 A local train without stoppages runs at an average speed of 70 km/hr, and with
stoppages, at an average speed of 30 km/hr. What is the total time (in hours) taken by
the local train for stoppages on a route of length 630 km?

Ans 1. 10

2. 12

3. 8

4. 19

Q.55 The value of 596 × 604 is:
Ans 1. 359984

2. 366958

3. 364199

4. 356822

Q.56 What will come in place of the question mark (?) in the following equation, if ‘+’ and ‘−’
are interchanged and ‘×’ and ‘÷’ are interchanged?

76 ÷ 9 + 818 × 2 − 93 = ?
Ans 1. 368

2. 388

3. 398

4. 378

Q.57 Find a single discount (rounded up to two decimal places) equal to three consecutive
discounts of 3%, 27% and 23%.

Ans 1. 45.73%

2. 43.03%

3. 45.48%

4. 45.34%
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Q.58 Which aspect of life is explored under the theme of akam in Sangam literary works?
Ans 1. Deed

2. Politics

3. War

4. Love

Q.59 Which of the following is NOT located in the Andaman group?
Ans 1. Neil

2. Minicoy

3. Barren

4. Havelock

Q.60 How many rural households were graded based on deprivation criteria, as per Socio
Economic and Caste Census (SECC) that was concluded by the Ministry of Rural
Development in March, 2016?

Ans 1. 7.72 crore

2. 8.72 crore

3. 9.72 crore

4. 6.72 crore

Q.61 In MS Word 365, which feature allows users to set specific spacing before and after
paragraphs to control the vertical space between paragraphs and improve document
readability?

Ans 1. Paragraph Spacing

2. Indentation

3. Line Spacing

4. Page Layout

Q.62 Where can people of Indian origin living abroad apply for Indian citizenship under
Article 8?

Ans 1. Indian Embassy in Delhi only

2. Indian Embassy at their country of living

3. State government office

4. Supreme Court

Q.63 Kanchan’s salary is ₹12,000 per month. He spends ₹4,000 on house rent and ₹2,000 on
bills, and the rest of the amount is his monthly savings. Find his savings (in ₹) in a year,
if in the month of his birthday, he spent all his monthly savings on birthday
celebrations.

Ans 1. 60,000

2. 54,000

3. 72,000

4. 66,000

Q.64 Which of the following states recorded the highest Schedule Tribes (ST) sex ratio in
2011, as per the Census of India data?

Ans 1. Goa

2. Tamil Nadu

3. Arunachal Pradesh

4. Mizoram
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Q.65 According to a Morgan Stanley Report, how much is India’s infrastructure investment
expected to increase as a percentage of GDP by FY29?

Ans 1. 6.5%

2. 4.5%

3. 7.0%

4. 5.3%

Q.66

Ans 1. 17 hours

2. 10 hours

3. 24 hours

4. 7 hours

Q.67 Who among the following is NOT eligible for the subsidy under the PMAY-U 2.0 scheme
launched in 2024?

Ans 1. Middle Income Groups (MIG) having an annual income of up to ₹9 lakh per year

2. Families given housing by any government scheme in the past 20 years

3. Individuals from Economically Weaker Sections (EWSs)

4. Individuals with annual income up to ₹6 lakh

Q.68 QQ 3 is related to NU -1 in a certain way. In the same way, OK 11 is related to LO 7. To
which of the given options is PL -2 related, following the same logic?

Ans 1. MQ -4

2. NQ -6

3. MP -6

4. NP -4

Q.69 The endangered bird species found in the Thar Desert is:
Ans 1. Hornbill

2. Flamingo

3. Great Indian Bustard

4. Pelican

Q.70 Three numbers are in the ratio 2 : 14 : 3, and their LCM is 4116. Their HCF is:
Ans 1. 98

2. 108

3. 100

4. 95

Q.71 In MS Word, if you want to duplicate a selected text without removing it from its original
location, which set of commands should you use?

Ans 1. Select → Move

2. Delete → Undo

3. Cut → Paste

4. Copy → Paste
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Q.72 The Ministry of MSMEs in India celebrates the MSME Day on ______.
Ans 1. 14 April

2. 27 June

3. 30 January

4. 7 June

Q.73 The median of the observations 34, 58, 98, 42, 83, 62, 12, 11, 87, 75 and 15 is:
Ans 1. 75

2. 42

3. 58

4. 62

Q.74 If ‘A’ stands for ‘÷’, ‘B’ stands for ‘×’, ‘C’ stands for ‘+’ and ‘D’ stands for ‘−’, then what
will come in place of the question mark (?) in the following equation?

(46 B 8) A 16 C 15 B 3 D 27 =?
Ans 1. 29

2. 68

3. 41

4. 52

Q.75 Which Indian state/Union territory had the highest urbanised population, as per the
Census 2011?

Ans 1. Tamil Nadu

2. Maharashtra

3. Goa

4. Delhi

Q.76 A vendor sells oranges at ₹44 each and incurs a loss of 78%. If he wants to make a
profit of 78%, at what price (in ₹) should he sell each orange?

Ans 1. 355

2. 358

3. 354

4. 356

Q.77 12 is related to 4 following a certain logic. Following the same logic, 24 is related to 8.
To which of the following is 60 related, following the same logic?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 – Operations on 13 such as
adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

Ans 1. 15

2. 20

3. 30

4. 25

Q.78 Seven people, I, J, K, L, O, P and Q are sitting in a row, facing north. Only two people sit
to the right of I. Only two people sit between I and O. Only two people sit between J and
P. P sits to the immediate left of I. Q sits to the immediate right of L. Who sits at third
position from the left end of the line?

Ans 1. I

2. K

3. O

4. Q
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Q.79 What is the dimensional formula of pressure?
Ans 1. [M L⁻² T⁻²]

2. [M L⁻¹ T⁻²]

3. [M L² T⁻²]

4. [M L T⁻²]

Q.80 The ratio of the lengths of two corresponding sides of two similar triangles is 10 : 9. The
ratio of the areas of these two triangles, in the order mentioned, is:

Ans 1. 100 : 81

2. 10√10 : 9

3. 101 : 82

4. 10 : 9

Q.81 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?
# : OLR :: LIO : %

Ans 1. # = RPO, % = MKP

2. # = YTU, % = LKJ

3. # = PKI, % = IMJ

4. # = ROU, % = IFL

Q.82 Two taps can fill a cistern in 3 hours and 18 hours, respectively. A third tap can empty it
in 72 hours. How long (in hours) will it take to fill three-fourth of the empty cistern, if all
of them are opened together?

Ans 1. 8

2. 4

3. 2

4. 6

Q.83 QP 15 is related to TR 6 in a certain way. In the same way, KN 8 is related to NP −1. To
which of the given options is LO 3 related, following the same logic?

Ans 1. OQ −6

2. BH −4

3. YR −7

4. OP −9

Q.84 Who among the following was awarded the Grand Collar of the Timor-Leste in August
2024?

Ans 1. Droupadi Murmu

2. Om Birla

3. Dr. S Jaishankar

4. Narendra Modi

Q.85 OJ 9 is related to QM -8 in a certain way. In the same way, JK 14 is related to LN
-3. To which of the given options is VP 1 related, following the same logic?

Ans 1. XT -16

2. YT -16

3. XS -16

4. YS -14
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Q.86 Which of the following ratios is greatest?
Ans 1. 25 : 50

2. 20 : 36

3. 17 : 42

4. 21 : 45

Q.87 Akash sold an article at a loss of 21%. If he had bought the item at 8% less and had sold
it for ₹198 more, then he would have gained 5%. Find the cost price (in ₹) of the article.

Ans 1. 1,125

2. 686

3. 685

4. 1,419

Q.88

Ans 1. 

2. 

3. 

4. 

Q.89 Which Delhi Sultanate ruler was associated with the expedition of Bhilsa (Vidisha) in AD
1292?

Ans 1. Ghazi Malik

2. Alauddin Khilji

3. Ulugh Khan

4. Iltutmish

Q.90 In January 2025, who became the first Indian to be nominated for Best Director (Motion
Picture) at the Golden Globe Awards?

Ans 1. Payal Kapadia

2. Mira Nair

3. Meghna Gulzar

4. Zoya Akhtar

Q.91 In a certain code language, ‘FISH’ is coded as ‘6147’ and ‘SALE’ is coded as ‘9512’. What
is the code for ‘S’ in the given code language?

Ans 1. 4

2. 5

3. 9

4. 1

Q.92 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.
(NOTE: All numbers are single digit numbers only.)

(Left) 5 $ 6 @ 3 * 6 4 & $ 2 9 5 9 € £ 7 8 # 1 & 2 (Right)

How many such numbers are there each of which is immediately preceded by a symbol
and also immediately followed by a symbol?

Ans 1. 3

2. 4

3. 2

4. 5
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Q.93 What should come in place of the question mark (?) in the given series?

842 840 836 830 822 ?
Ans 1. 810

2. 814

3. 808

4. 812

Q.94

Ans 1. 

2. 

3. 

4. 

Q.95 Who among the following has become the 11th Chairman of Securities and Exchange
Board of India in February 2025?

Ans 1. Dr. Mayank Sharma

2. Manan Kumar Mishra

3. Tuhin Kanta Pandey

4. Ajay Seth

Q.96 In February 2025, which international organisation signed a strategic partnership with
the African Union to boost vaccine manufacturing on the continent?

Ans 1. World Health Organization

2. GAVI – The Vaccine Alliance

3. International Monetary Fund

4. World Bank

Q.97 What is the advantage of keeping food in an airtight container?
Ans 1. It promotes anaerobic bacterial growth.

2. It slows down oxidation.

3. It changes the colour of the food.

4. It enhances the taste of the food.

Q.98 Which of the following countries experienced widespread protests in May 2025 due to
the government's decision to dissolve all political parties and extend the presidential
term?

Ans 1. Mali

2. Niger

3. Chad

4. Sudan

Q.99 What should come in place of the question mark (?) in the given series based on the
English alphabetical order?
TMP RKN PIL NGJ ?

Ans 1. LEH

2. LFH

3. LFG

4. LEG
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Q.10
0

Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which letter-cluster pair DOES NOT
belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. DZ – IB

2. GC – LF

3. IE – NG

4. QM – VO
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